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TDY Requisition 

1.   Navigation 
Navigate to the Requisition Header window by selecting Requisitions > Requisitions 
from the navigator menu.  

• The Event Transaction Event window appears. 

 

• The system will automatically populate the Transaction Event field to 
Requisitions and the Transaction Code field to Commitments. 

• Select  to enter the requisition information. 
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2.   Requisition Header 
 

 

• Enter a description of the travel in the Description field.  This information print 
in the DD1610 remarks section along with the Attachment (detailed below) text. 

• Use the tab key to go to the Descriptive Flexfield .  The Requisition 
Headers window appears. 

 

• Use the list of values icon to select TDY and click  to enter additional 
header information. 

 

• Enter the following information: 
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Requisitions Headers – 
TDY 

Instructions Comments 

Requisition Type TDY Defaults from previous 
window selection. 

TRAVEL PURPOSE 
CODES 

Select List of Value icon and 
select the travel purpose code.  

This code prints in Block 9 
on the DD1610.  

TRAVELER’S NAME Enter the traveler’s name Enter last name then select 
tab key.  If more than one 
last name, select from the 
list of names. 

Approx. No Days of TDY Enter number of days on travel.  
Proceed Date Enter first date of travel. (Ex. 

05-DEC-05) 
Valid date entry examples: 
05-DEC-05 or 05-FEB-
2005 

ITINERARY FROM Enter the origination point of 
the TDY travel 

 

INITERARY TO Enter the destination(s) of the 
TDY travel (and RETURN). 
For example, Denver, CO and 
Return 

If this is a round trip ticket, 
make sure you type “AND 
RETURN” in the to field in 
order to return to the 
origination point. 

COMMERCIAL 
TRANSPORTATION 

Click on the field.  Select List 
of Value icon and select the 

Valid entries are: AIR, 
BUS, RAIL, SHIP or 
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Requisitions Headers – 
TDY 

Instructions Comments 

commercial travel. NONE 
GOVERNMENT 
TRANSPORTATION 

Enter any mode of Government 
provided transportation 

Valid entries are: G-
VEHICLE, GOV-AIR, 
GOV-SHIP and NO GOV 

LOCAL 
TRANSPORTATION 

Enter any mode of local 
transportation 

Valid entries are: CAR 
RENTAL, OTHER, TAXI 
and NO LOCAL 

PER DIEM 
AUTHORIZED PER JTR 

Enter “Yes” when using the 
JTR and “No” when other rate 
is authorized 

Access JTR to 
determine/confirm what Per 
Diem rate is in effect for 
each trip. 

OTHER PER DIEM RATE  Enter the Authorized Per Diem 
rate 

 

ADVANCE 
AUTHORIZED 

Enter any authorized advance 
amount 

 

 

• Click  to return to the Requisitions window. 

 

3.   Item Tab 

 

Items Section – TDY Orders:  

Line 1: Per Diem and Other combined. Use Travel Cost Type = 
“Other”. Rental cars and mileage should be included on this line.  
IBA (Individually Billed Account – Government Charge Card 
issued to employees) travel is also included on this line. 

Line 2: Travel line is limited to CBA (centrally billed account) 
commercial agent travel such as airfare, railroad, bus ticketed by 
Sato, Carlson Wagonlit or other ticket agencies. 
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• Enter the following information on the Items Tab:  

Requisitions – Items Tab Instructions Comments 
Scroll Left   
NUM  Required. System assigns line 

numbers. 
Type Select “Services” from the 

list of values 
Required.  Defaults to 
Services. 

Item  Optional. Not used at this 
time. 

Rev Displays revision number. Display only.   
Category Enter % then tab key to 

display the List of Values.. 
Required. LOV instructions: 
Enter % then tab key.  List of 
value appears.  Start typing 
TDY or enter value in the 
Find field.  Scroll to highlight 
your department/command.  
Select OK. 

Description Enter a description to 
explain the item in further 
detail. For example,  
Line 1: Per Diem and Other 
Line 2: CBA Travel  

Required.   Enter “CBA 
Travel” for Commercial 
Travel paid by CBA 
(Centrally Billed Account) 
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Requisitions – Items Tab Instructions Comments 
Scroll Right   
UOM (Unit of Measure) Tab key move to next field. Required 

Services = US Dollars 
Quantity Services – Enter travel or 

service amount. 
Goods – Enter quantity. 

Required.  Do not enter $ or 
“,”.  (Ex.  $5,700.25 = 
5700.25). 

Price Enter goods unit price. Required 
Services = Defaults “1”. 
Goods = Unit Price. 

Need-By  Optional. Not used at this 
time. 

Tax Code  Display Only. Not used at this 
time. 

Charge Account  Displays account information 
for the line when distribution 
is completed. 

Amount System computed. 
(Quantity * Price). 

Required. Defaults. 

Transaction Code “Commitments” Required. Defaults. 
 DFF Enter Standard Document 

Number  
Required.  See additional 
information below 

 

Item Descriptive Flexfield (DFF)  

 

• Enter “TDY” in the Standard Document Number (SDN) field as a temporary 
placeholder. The SDN will be populated by the system when the TDY line is 
saved.  

• Enter the travel cost type in the TRAVEL COST TYPE field.  

o Use the list of values icon to select OTHER for per diem and other costs 
(mileage, rental car, IBA travel) combined in Line 1.  

o For line 2, select TRAVEL for CBA (Centrally Billed Account) 
commercial agent travel such as airfare, railroad, bus ticketed by Sato, 
Carlson Wagonlit or other ticket agencies.  
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• Click  to return to the Requisitions window. 

 

• Enter the following information: 

Requisitions  Instructions Comments 
Destination Type “Expense” Required. Defaults 
Requestor Same as Requestor. Required. Defaults to user 

preparing requisition. Same as 
the Preparer field. 

Organization “SDDC Global” Required. Place the cursor in 
the field and click the list of 
values menu. “SDDC Global” 
will automatically populate. 

Location Enter the Requestor’s 
location. 

Required. Use the list of 
values to find the location 

Source “Supplier” Required. Defaults. 
Supplier Enter the supplier. Optional. Select supplier or 

employee for payment. See 
information note below. 

Site Enter the site location if 
applicable. 

Optional. However, if you 
enter a supplier you are 
required to enter a site.  Select 
“From CCR”. 

Contact Enter supplier contact or 
select from the list of 

Optional.  Not used at this 
time. 
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Requisitions  Instructions Comments 
values. 

Phone Enter supplier phone or 
select from list of values 

Optional. Not used at this 
time. 

 

 

Supplier Field:  

• When the Travel Cost is to be reimbursed to the Employee, the 
Supplier is the Employee. 

• When the Travel Cost for CBA (Commercial Billed Account) 
commercial travel (airfare, rail, bus), the Supplier is Bank of 
America. 

 

 

• Click  to enter the project and task information. 

 

4.   Distribution 
• Select the Project tab. 

 

• Enter the following information on the Project tab: 

Project - Tab  Instructions Comments 
Project Enter or use the list of Required.  
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Project - Tab  Instructions Comments 
values to select the project.  

Task Enter or use the list of 
values to select the task. 

Required.  

Type Select from the list of 
values the expenditure type. 

Required. 

Org Select from the list of 
values the expenditure 
organization. 

Required. 

Date Enter proceed date of travel. Required.  Select LOV to 
display calendar or enter NN-
MON-YEAR format.. 

Quantity Defaults. Can be modified 
for multiple distribution 
lines. 

Required The system allows 
multiple distribution lines for 
a single requisition line. If the 
sum of the distribution 
quantities disagrees with the 
line item., the user cannot 
submit the requisition for 
approval. 

 
• Click  to save the distribution information. The Accounts Description 

information is automatically populated when the document is saved. 

• Close the Distribution window and return to the Requisitions window. 

• If an additional line is required for the CBA (Paid by SDDC central billed 
account) commercial travel, repeat Section 3 (Items Tab) and Section 4 
(Distribution) to complete the Line 2 for Travel Transportation (Airfare, Bus and 
Rail). 2., otherwise, go to Section 5 (Attachment). 
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5.   Attachment 
The requisition attachment is used to document any special requirements for the TDY 
order. Data entered in the attachment will be printed in Block 16 – Remarks of the 
DD1610.  
 

 
 
 

• Place the cursor in the header Description field. 

• On the Tool bar, click  to go to the Attachments window. 
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• Enter the following information: 
 

Attachments  Instructions Comments 
Seq Defaults Required.  
Category Enter Miscellaneous Required.  
Description  Not required. 
Data Type Select “Long Text” from 

the list of values 
Required. 

 
• Enter the Remarks in the text region. 

 

 

Remarks:  

• When a privately owned conveyance is to be used enter the Rate 
per Mile authorized per the following example:  

o Rate per Mile: $0.365 

• When travel is overseas, the following comment must be used: 
“Transportation Mode as determined by appropriate 
Transportation Officer” 
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• Click  to save. Close the Attachments window and return to the 
Requisitions window. Write down the requisition number found in the 
Number field for future reference. 

 

6. Submit for Approval 

Once the requisition is complete, select from the Requisition 
window to open the Approve Document window: 
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• Enter the following information on the Approve Document window:  

Approve Document Instructions Comments 

Reserve Always click on the 
check box to enable. 

Required 

Submit for Approval  Defaults enabled.   
Forward From  Optional 
Approval Path  Optional 
Forward To  Optional 
Note  Note to Approver 
Print  Skip 

 

• Select  to continue. The system will perform a funds 
check. 

 

7. Funds Check 
When the requisition has been submitted for approval and the “Reserve” checkbox has 
been highlighted the system checks that the requisition does not exceed the available 
funds.  

 

• Select  to proceed.  The following confirmation appears to notify the user 
that the requisition has passed the submission checks. 
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• Select to proceed.  The following confirmation appears to notify the user 
that the requisition is submitted for approval 

 

• Select  to proceed. The document is submitted for approval.  The 
requisition will be automatically routed to the required approver.    

 

8. Funds Check - Failed 
• The follow message appears when the requisition exceeds the available funds. 

 

• Select  .  Below is a sample of the Approval Errors window that displays 
and explanation. 
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• Select .  Review the requisition and verify that the project, task, 
expenditure type, expenditure organization is correct. If the information is correct, 
contact the Budget department to resolve issue. 

 

9.  Approval Notification  
When the final approver approves the requisition the system generates a notification to 
the preparer.   

• Navigate to the Notifications Summary from the Navigator window.  The 
following Worklist window displays the notifications to the requestor. 

 

 

• View additional detail by clicking on the subject line.  The following is a sample 
of the detail available: 
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• Select    to return to the Worklist. 

• Close the Worklist browser to return to the Navigator window. 

• TFMS generates email notifications if the user has turned on Email Notification in 
the Preferences section of the Notification Summary. 

• Print the Approved TDY Requisition for the traveler’s use and records.   

 

10.  Print the TDY Requisition 
 

• Navigate to the Find Requests window from the Navigator window by selecting 
View > Requests from the menu bar.  

  17 



 

 

 TDY Requisition and DD1610 Desktop Reference  

 

• Select . The following message 
appears: 

 

• Select  to submit a Single Request. 
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• In the Name field, click the list of values to select MTMC DD1610 TDY FORM. 
 

• Click  to enter the parameter. 

 

• Enter the requisition number in the Requisition Number field. 

• Click  to continue. 
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• Click  to submit the request. 
 

 
 

• Click  to monitor when the request Phase is 
Completed and the Status is Normal. 
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• Once the request is in the Completed phase and Normal status, click 

 to view the DD1610 online. The 
DD1610 will be presented on the screen as an Acrobat file. By selecting the Print 
button on the menu bar, the DD1610 will be printed to your local printer.  You 
may save a copy of the print file by selecting the file button on the menu bar and 
choosing “Save a Copy…” 
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11. Amendments to TDY Requisition (Order) 
 

• If changes to the TDY requisition are required prior to the travel date, check to make 
sure the requisition has not been obligated.  

o If the requisition has been obligated, have the approving official send an email to 
the TFMS-M Help Desk to cancel the purchase order and return the requisition to 
the Requestor. The TFMS-M Help Desk will forward the request to G8 in order 
for G8 to cancel the PO and return the requisition. 

o If the requisition has not been obligated, send an email to the TFMSM Help 
Desk to return the requisition for adjustment. The TFMS-M Help Desk will 
forward the request to G8 in order for G8 to cancel the PO and return the 
requisition. Once the adjustments are made, resubmit for approval.   

 

How to tell if a requisition has been obligated:  

• Go to Requisition Summary. 

• Enter your requisition number in the Requisition Number field.

• Select Lines under Results. 

• Click the Find button to go to the Requisition Line Summary 
window. 

• Scroll to the right to locate the Order Number field. If a 
number is in this field then your requisition has been obligated. 
If the field is blank that means your requisition has not been 
obligated. 

 

• If changes to the TDY requisition are required after the travel date, create a new 
requisition. Enter “Amendment to requisition XXXXX” in the Description field and 
enter the original standard document number in the Standard Document Number 
field. (To locate the original standard document number, follow the steps in the 
information box above). Submit requisition for approval. 

• If change to text or traveler’s information only, add a new line for $ .01 (penny). 

• If additional funding is required, add a new requisition for the additional funding 
only. 

• If the amount is to be reduced, no changes are required because the amount will be 
adjusted at the settlement of the TDY. 
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